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APPENDIX C

This appendix contains the various data collection logs and questionnaires that were utilized for the TIC
Architecture and User Interface evaluation. The contents of the appendix are as follows:
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TIC Evaluator Observation Sheet Criteria

The following represent the criteria which will be utilized to guide the observations made by the
evauator when observing TIC operation. This list is not exhaustive but will be used as the basis for
the evaluator observation sessions. In addition, it is likely that not all of the criteria will be applicable
depending on the events which occur during the observation sessions. The observations will be made
in free-form.  The names of the operator on duty at the TIC and the evaluator performing the
observations will also be noted on this sheet. Following the session, the observations recorded will be
]E:Iﬁssified into several types to facilitate analysis. The observation criteria have been grouped as
ollows:

A - Workload

demands made of operator and operator responsveness relating to data requiring manual input
demands made of operator and operator responsiveness relating to processes requiring
monitoring

amount of time operator is involved performing each type of task

number and type of external interruptions

effect of external interruptions on productivity

any other difficulties experienced

B - Working practices

effectiveness of operator reporting structure

number and type of instances where TIC policy and procedures impact TIC operation
effect of staffing levelson TIC ecc)f)eration and operator workload

any other difficulties experienc

C - Operator characteristics

type and effectiveness of problem-solving methods used
effect of operator work-style on productivity
any other difficulties experienced

D - Human factors

effect of overall physica layout of the TIC on operations

effect of workstation layout on TIC operations

effect of screen layout on TIC operations

effect of task and menu structure on TIC operations, including font sizes, types, etc.
type, appropriateness, and quality of feedback provided by the system

number and type of difficulties experienced by operators when using TIC systems

E - TIC functionality

functions not utilized during regular TIC operations

possible additional functions which would ease operator workload, streamline T1C processes or
improve TIC efficiency

any other difficultiesexperienced

Document #8464.TI1C.03
TIC Evaluation Report c3



ADVANCE July 15.1996

Date Page of

TIC Evaluator Observation Sheet

Time

DF.T.E.T.P..evauatr.sht

Document #8464.TIC.03
TIC Evaluation Report

c4



ADVANCE

July 15.1996

TIC Evaluation Questionnaire

This questionnaire has been designed to help evaluate various aspects of the general
operation and the user interface of the ADVANCE TIC. Itisnot being used to assess

individual operator performance or knowledge. The questionnaire should take about half ~Responses
an hour to complete. _
(Circle/ check

The first half of the questionnaire concerns the policies, procedures and staffing levelsof — as appropriate)
the ADVANCE TIC and the second part concerns the TIC User Interface. However, first
I"d like to ask you some brief questions about yourself. MI[] FI[I
I Which of these rangesreflectsyour age?

1) 18-25 2) 26-35 3) 36-45 4)46-55 5)56-65 6) 66 and above 123456
2 Which of thefollowing options reflects your level of education?

1) High school  2) Currently attending college 3) Graduated from college 1 2 3 4

4) Graduate school
3 Tothenearest month, how long haveyou beenworking at the TIC? ...
Part 1
The next part of the questionnaire concerns the working practices at the TIC.
4 How familiar are you with the TIC Policies and Procedures Manual? This is the main

policies reference document which contains the Daily T1C Operations Procedures.

1) Very familiar 2) Familiar 3) Not very familiar 1 2 3
5  How frequently do you consult the TIC Policies and Procedures Manual?

1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 12 3 4 56

times per month 5) Less frequently 6) Never. (If ‘never’, go to question 7.)
6  How useful have you found the T1C Policies and Procedures Manual when seeking

guidance on how to respond to situations?

1) Very useful 2) Useful 3) Not very useful 1 2 3
7 When monitoring the TRF subsystem, how frequently have you had to manually

validate TRF results when an apparent malfunction occurred?

1) More than once per day 2) Once per day 3) A few timesperweek 4) Afew 123456

times per month 5) Less frequently 6) Never. (If ‘never’, go to question 8.)

Have you ever experienced any difficulties in performing this task?

1) Yes 2) No. If ‘yes’, please describe them. 1 2
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8  When monitoring the frequency that the TIC updates the travel timesin the MNAs,
how frequently have you had to request a new travel time database, (static profiles)?
1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 123 456
times per month  5) Lessfrequently 6) Never. (If ‘never’, go to question 9.)

Have you ever experienced any difficultiesin performing this task?
1) Yes 2) No. If ‘yes, please describe them. 1 2

9  How often have you had to handle emergency telephone calls from project drivers
outside normal office hours?
1) More than once per day 2) Once per day 3) A fewtimesper week 4) Afew 123456
times per month  5) Lessfrequently 6) Never. (If ‘never’, go to question 10.)

Have you ever experienced any difficultiesin performing this task?
1) Yes 2) No. If ‘yes, please describe them. 1 2

10 Have you ever experienced any adverse impacts on the operation of the TIC due to the
scheduling of maintenance activities?
1) Yes 2) No. If ‘yes, please describe any difficulties experienced. 1 2

11 Have you ever been involved in the verification of an update of the travel time
database?
1) Yes 2) No. 1 2

If ‘yes’, did you ever experience any difficultiesin performing this task?
1) Yes 2) No. If ‘yes’, please describe them. 1 2
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12 How often have you been involved in processing the MNA memory cards, that is,
downloading the travel time data contained on the cards, erasing the cards and
returning them to the MNAs?
1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 12 3 456
times per month 5) Less frequently 6) Never. (If ‘never’, go to question 13 )

Have you ever experienced any difficultiesin performing this task?
1) Yes 2) No. If ‘yes', please describe them. 1 2

13 How frequently have you been involved in an emergency shutdown of the TIC?
1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 123456
times per month  5) Less frequently 6) Never. (If ‘never’, go to question 18.)

14 Did you experience any difficulties in diagnosing the specific problem which
necessitated an emergency shutdown?
1) Yes 2) No. If ‘yes, please describe them. 1 2

15 Did you have any difficulties in judging whether the problems experienced warranted
an emergency shutdown?
1) Yes 2) No. If ‘yes, please describe them. 1 2
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16 Were there ever any unforeseen consequences of performing any emergency

17

18

19

20

21

shutdowns?
1) Yes 2) No. If ‘yes, please describe them.

Did you receive al the technical support you needed to restore TIC operation from an
emergency shutdown?
1) Yes 2) No. If ‘no’, please describe any difficulties experienced.

How frequently have you been involved in planned shutdowns of the TIC?
1) More than once per day 2) Onceper day 3) A few times per week 4) A few
times per month 5) Lessfrequently 6) Never”. (If ‘never’, go to question 21.)

Were there ever any unforeseen consequences of performing any planned shutdowns?
1) Yes 2) No. If ‘yes, please describe them.

Did you receive al the technical support you needed to restore TIC operation from a
planned shutdown?
1) Yes 2) No. If ‘no’, please describe any difficulties experienced.

Have you ever experienced any communication subsystem malfunctions, that is, any
problems with the RF modems in the equipped vehicles?
1) Yes 2) No. (If ‘no’, go to question 24.)
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22 Did you experience any difficulties in diagnosing a communication subsystem
malfunction?
1) Yes 2) No. If ‘yes, please describe them. 1 2

23 Didyou receive al the technical support you needed to restore the communications
subsystem to full operation?
1) Yes 2) No. If ‘no’, please describe any difficulties experienced. 1 2

24 Haveyou ever beeninvolved in any updates of the TIC software or hardware, or the
testing of updates that were made?
1) Yes 2) No. 1 2

If ‘yes, did you ever experience any difficulties in performing these tasks?
1) Yes 2) No. If ‘yes, please describe them. 1 2

25 How frequently do you perform backups of TIC databases and applications software?
1) More than once per day 2) Onceperday 3) A few times per week 4) A few 123456
times per month 5) Less frequently 6) Never. (If ‘never’, go to question 26.)

Have you ever experienced any difficulties in performing this task?
1) Yes 2)No. If ‘yes, please describe them. 1 2
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26 Have you ever had to authorize and make a change to any of the TIC subsystemsin
response to a critical malfunction in order to keep the TIC operational ?
1) Yes 2) No. 1 2

If ‘yes’, did you experience any difficultiesin having the change approved by senior
staff after it had been made?
1) Yes 2) No. If ‘yes’, please describe them. 1 2

27 How frequently have you handled requests for information from ADVANCE project
participants, not including the drivers of the equipped vehicles?
1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 12 3 4 56
times per month 5) Lessfrequently 6) Never. (If ‘never’, go to question 28.)

Were you easily able to obtain approval for providing the information?
1) Yes 2) No. If ‘no’, please describe the situation. 1 2

28 How frequently have you handled requests for information from outside the
ADVANCE project?
1) More than once per day 2) Once per day 3) A few timesper week ) Afew 123 456
times per month 5) Lessfrequently 6) Never. (If ‘never’, go to question 29.)

Were you easily able to obtain approval for providing the information?
1) Yes 2) No. If ‘no’, please describe the situation. 1 2

29 Haveyou ever been requested to provide any personal information held about drivers
of MNA equipped vehicles or their movements in the test area from outside the
ADVANCE project?
1) Yes 2) No. If ‘yes', what action was taken, and was the outcome? 1 2
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30

31

32

33

Has assisting the evaluation team in collecting data for the ADVANCE evaluation
caused any difficulties for the operation of the TIC or your own workload?
1) Yes 2) No. If ‘yes', please describe them.

Has any ADVANCE project participant other than UK-EECS ever requested online
accessto the TIC or attempted to log in to the TIC system?
1) Yes 2) No. If ‘yes, what action was taken, and what was the outcome?

Has the UK-EECS online accessto the TIC ever adversely affected the operation of
the TIC?
1) Yes 2) No. If ‘yes, what action was taken, and what was the outcome?

Have you ever been aware of any unauthorized changes to the TIC systems being
made using the remote access links with the UK-EECS?
1) Yes 2) No. If ‘yes, what action was taken, and what was the outcome?
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34 According to the scale provided, how would you assess your workload
during the following times: _ _
1) Very heavy  2)Heavy 3) Moderate  4) Light  5) Very light

6.00am to 9.00am
9.00am to 4.00pm
4.00pm to 6.00pm
6.00pm to 7.00pm

P RERe
NN NN
wWwWww
AP DN
qoaia

35 The TIC system manager is on duty at the project office during regular office hours.
Have you ever required any input or guidance from the system manager outside these
hoursin order for you to fulfil your TIC operator duties?
1) Yes 2) No. If * yes , please describe the situation. 1 2

36 Arethere any other issues you would like to mention relating to policies, procedures
or staffing levels of the TIC which have not been covered by the above questions?
1) Yes 2) No. If ‘yes’, please provide further details 1 2

Part 2

The second half of the questionnaire concerns the usability and functionality of the TIC
User Interface.

37 How familiar are you with the TIC Console Operator’s User Manual?
1) Very familiar 2) Familiar 3) Not very familiar 1 2 3

38 How frequently do you consult the TIC Console Operator’s User Manual ?
1) More than once per day 2) Once per day, 3) A few timesper week 4)Afew 123456
times per month 5) Lessfrequently 6) Never. (If ‘never’, go to question 40.)

39 How useful have you found the TIC Console Operator’s User Manual when seeking
information on how to operate the TIC systems?
1) Very useful 2) Useful 3) Not very useful 1 2 3
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40 How familiar were you with Windows-based computer systems before starting work
athe TIC?
1) Very familiar 2) Familiar 3) Not very familiar 1 2 3

If ‘not very familiar’, approximately how long did it take for you to feel comfortable

working with the Windows-based system?

1) Less than an hour 2) One hour 3) One day 4) Severa days5) Morethana 1 2 3 4 5
week

41 How familiar were you with the UNIX operating system and commands before
starting work at the TIC?
1) Very familiar 2) Familiar 3) Not very familiar 1 2 3

If “not very familiar’, approximately how long did it take for you to feel comfortable

working with the UNIX operating system and commands?

1) Less than an hour 2) One hour 3) One day 4) Several days5) Morethana 1 2 3 4 5
week

42 Does the layout of the TIC room, such as the positioning of the workstations, printer,
computer cabinet, etc., affect the ease with which you can perform your daily tasks?
1) Yes 2) No. If ‘yes, please provide further details 1 2

43 How would you assess the ease with which you can manipulate the test area map on
the TIC monitor, for example zooming in and out, resizing this window, and scrolling
acrossit?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 1 2 3 45
4) Moderately difficult 5) Very difficult

If *moderately or very difficult’, could you describe any problems you experienced.

44 With respect to the colors that are used on the test area map, how would you assess the
ease with which you can distinguish the different types of road and any highlighted
segments on the monitor?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 1 2 3 45
4) Moderately difficult 5) Very difficult
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TIC Evaluation Report ClI3



ADVANCE July 15.1996

If “moderately or very difficult’, could you describe any problems you experienced.

45 Do you display the icons which represent incidents and road or lane closures when you

areon duty at the TIC?
1) Yes 2) No. (If ‘no’, go to question 48.) 1 2

46  With respect to the icons that are used to represent incidents, road or lane closures,
probe vehicles, etc. on the TIC monitor, how would you assess the ease with which
you can distinguish between the different types of icons?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 12345
4) Moderately difficult  5) Very difficult

If “moderately or very difficult’, could you describe any problems you experienced.

47 At busy times when many icons are present on the test area map, how would you
assess the ease with which you can monitor the overall roadway status?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 12345
4) Moderately difficult 5) Very difficult

If “moderately or very difficult’, could you describe any problems you experienced.

For the next few questions, you may find it useful to take alook at the test area map menus.

48 Arethere any items on the Monitor Menu that you have experienced difficulty in
using?
1) Yes 2) No. If ‘yes, please describe these difficulties. 1 2
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49 Arethere any items on the Monitor Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, pleaselist theitems 1 2

50 Are there any items on the Display Menu that you have experienced difficulty in
using?
1) Yes 2) No. If ‘yes', please describe these diffkulties. 1 2

51 Arethereany itemson the Display Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, pleaselist the items 1 2

52 Arethere any items on the Select Menu that you have experienced difficulty in using?
1) Yes 2) No. If ‘yes', please describe these diffkulties. 1 2

53 Arethere any items on the Select Menu that you very rarely or never use?
1) Yes 2)No. If ‘yes, please list the items 1 2

54 Are there any items on the Locate Menu that you have experienced difficulty in using?
1) Yes 2) No. If ‘yes', please describe these difficulties. 1 2
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55  Arethere any items on the Locate Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, please list the items 1 2

56 Are there any items on the View Menu that you have experienced difficulty in using?
1) Yes 2) No. If ‘yes’, please describe these difficulties. 1 2

57 Arethere any items on the View Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, please list the items 1 2

58 Arethere any items on the Input Menu that you have experienced difficulty in using?
1) Yes 2) No. If ‘yes, please describe these diffkulties. 1 2

59 Arethere any items on the Input Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, please list the items 1 2

60 Arethere any items on the Plot Menu that you have experienced difficulty in using?
1) Yes 2) No. If ‘yes, please describe these diffkulties. 1 2
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61 Arethereany itemson the Plot Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, pleaselist theitems 1 2

62 Arethere any items on the Data Pop-up Menu that you have experienced difficulty in
using?
1) Yes 2) No. If ‘yes, please describe these difficulties. 1 2

63 Arethereany items on the Data Pop-up Menu that you very rarely or never use?
1) Yes 2) No. If ‘yes, pleaselist theitems 1 2

64 How would you assess the ease with which you can locate and select items on the test
area map such as segments, links, roads, intersections, etc., using the menus provided?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 1 2 3 45
4) Moderately diffkult 5) Very diffkult

If *‘moderately or very difficult’, could you describe any problems you experienced.

65 With respect to the colors and the font sizes that are used on the test area map menus,
how would you assess the ease with which you can distinguish items in the menus?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 1 2 3 45
4) Moderately difficult 5) Very difficult

If *moderately or very diffkult’, could you describe any problems you experienced.
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66 Does thetime that the system takes to process commands and data ever introduce any
delays into the completion of tasks?
1) Yes 2) No. If ‘yes, please describe these situations.

For the next few questions, you may find it useful to open the various data windows as we
discuss them.

67 How would you assess the ease with which you can obtain the information you require
to complete any tasks or monitor the system status using the various data windows?
1) Very easy 2) Mbderately easy 3) Neither particularly easy nor difficult
4) Moderately difficult 5) Very difficult

If “moderately or very difficult’, could you describe any problems you experienced.

68 Can you estimate how frequently you use each of the following data windows,
according to the following scale:
1) More than once per day 2) Once per day 3) A few times per week 4) A few
times per month 5) Less frequently 6) Never.

MIF contents data window:

Static profile data window:

Link network attributes data window:

Segment network attributes data window:

Probe reports data window:

Link updates data window:

L oop detector data window:

Automatically generated incidents and closures data window:
Node information data window:

12345
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69 The various data input windows accessed through the input menu allow the manual
entry of anecdotal datainto the TIC system, and allow the test map properties to be
edited. According to thefollowing scale, how frequently do you enter data using the
types of datainput windows listed below?

1) More than once per day 2) Onceper day 3) A few times per week 4) A few
times per month 5) Less frequently 6) Never.

Incident reports and road or lane closures: 123456
Link updates: 123456
Map properties: 123456

Have you ever experienced any difficulties in performing these data input tasks?
1) Yes 2) No. If ‘yes', please describe them. 1 2

70  With respect to the colors and the font sizes that are used on the data input windows,
how would you assess the ease with which you can distinguish the various items in the
windows, such as the buttons, datainput fields, the clarity of the text against the
background, etc.?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 12345
4) Moderately difficult  5) Verydifficult

If *‘moderately or very difficult’, could you describe any problems you experienced.

71 How frequently do you access the Expressway Map and the GCM Home Page on the
Internet?
1) More than once per day 2) Onceper day 3) A fewtimesperweek 4)Afew 123456
times per month  5) Less frequently 6) Never. (If ‘never’, go to question 72.)

Have you ever experienced any difficulties in performing this task?
1) Yes 2) No. If ‘yes, please describe them. 1 2
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72 How frequently do you use the Static Update utility?
1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 12 3456
times per month 5) Lessfrequently 6) Never. (If ‘never’, go to question 73.)

Have you ever experienced any difficultiesin performing thistask?
1) Yes 2) No. If ‘yes, please describe them. 1 2

73 How would you assess the ease with which you can monitor the status of individual
processes using the TIC Process Controller?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 12345
4) Moderately difficult 5) Very difficult

If “moderately or very difficult’, could you describe any problems you experienced.

For the next few questions, you may find it useful to open the various TIC Process
Controller logs and files as we discuss them.

74 How would you assess the format of the data contained in the various log files
accessed through the TIC Process Controller, in terms of the ease with which you are
ableto find the information you need?
1) Vary easy 2) Moderately easy 3) Neither particularly easy nor difficult 12345
4) Moderately difficult 5) Very difficult

If “moderately or very difficult’, could you describe any problems you experienced.
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75 How would you assess the format of the error messages contained in the various status
files accessed through the TIC Process Controller, in terms of the ease with which you
are able to find the information you need?
1) Very easy 2) Moderately easy 3) Neither particularly easy nor difficult 12345
4) Moderately difficult 5) Very difficult

If *moderately or very difficult’, could you describe any problems you experienced.

76  How frequently do you usethe TIC Subsystem Controller?
1) More than once per day 2) Once per day 3) A few timesper week ) Afev 123456
times per month  5) Less frequently 6) Never. (If ‘never’, go to question 77.)

Have you ever experienced any difficulties in using this utility?
1) Yes 2) No. If ‘yes, please describe them. 1 2

77 How frequently do you use the TIC back-up utility?
1) More than once per day 2) Once per day 3) A few timesper week 4) Afew 123456
times per month 5) Less frequently 6) Never. (If ‘never’, go to question 78.)

Have you ever experienced any difficultiesin using this utility?
1) Yes 2) No. If ‘yes', please describe them. 1 2

78 If you were asked to re-design the TIC system interface having used the present
system, what changes would you make that would make your tasks more easy to
complete or that would ease your workload in any way?
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Thank you very much for your time and input. When the results of the questionnaires
have been analyzed, we may wish to discuss the findings with you at alater stage.
Operator ID: Date: Time:

DF: T.E.-T.P.: evalques.frm
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